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Digital Funhouse Info - Upgrade Features

The full version of Symsoft Digital Funhouse offers great fun for you, your friends, family 
and, yes, even your pets!. Scan color and BW photos into the Digital Funhouse (DF) and 
make your own photorealistic creations -- funny, artistic and serious -- then fax or print them
or put them into WP or DTP documents.

If you have ever seen those funny caricatures of Jay Leno or David Letterman, then you have
an idea of    what DF can do to photographs; because DF is like an electronic caricature artist.

DF allows you high-powered image processing previously available only in $550-$900 
professional image editing software. Now, for only $79.95 + S&H, you get the tools of the 
pros -- but faster and easier to use!    FAX us your order now and start getting creative!

Upgrade to Symsoft digital Funhouse and get the following great features:

Scanning: Scan in virtually any color or black and white photo using our built-in TWAIN 
scanner support. This is a great way to personalize your documents and faxes.

Faxing: Photorealistic faxing! You've never seen it before (because we're the first ones 
to do it) but believe it. Your faxed images will look nearly like a photo -- and you can 
enlarge it up to a full page!

Printing: Fabulous printing in both black and white and color. Photorealistic, only 
sharper than the FAX.

More Effects & Edits: Artistic:    pencil drawing, negative, pixelate    and oil painting; 
Sizing: fat, skinny, squash and stretch;    and copy/paste allow much more creative 
leeway for artistic and bizarre distortions.

File Saving: To all standard Windows graphics file formats. This    way you can save DF 
output to your favorite DTP, WP or graphics program.

Export: With export, you can save DF output especially processed for the highest quality
printing or faxing from your own DTP or WP application.

Image Enhancement: These tools are essential for high-quality scanner input: tone 
adjustments (brightness, contrast, gamma), color correction (R, G and B color 
intensities), sharpen (to sharpen blurry images) and remove spots (to get rid of specks 
on an image). 

Well, that about sums it up. Click on 'Order' on the right side of the top menu bar and fill out 
the order form. Then fax, mail or phone it in. You'll be laughing your head off in two days!



Restrictions of the Digital Funhouse Demo

A number of Digital Funhouse features are not available in this demo version of the program.
These features are summarized below.

Printing
Printing is not available in the demo.
File Formats
Modified images can only be saved in the Digital Funhouse DFG format. The demo can read 
a variety of file formats.
Effects
Some effects are not available in the demo. Effects in the Artistic Effects and Sizing Effects 
groups with a N/A (not available) next to the name are not available in the demo.
Export command
The Export command which saves images for use with other applications is not available in 
the demo.
Scanning
The image scanning commands (Acquire and Select Source) are not available in the demo.
Clipboard commands
The copy and paste commands are not available in the demo.
Image Enhancement commands
The image enhancement commands (Tone Adjustment, Color Correction, Sharpen and 
Remove Spots) are not available In the demo.



How to Order Digital Funhouse

Select the Order command from the menu bar. The Order dialog box can be used to print an 
order form.

Send orders to:
Symsoft Corp.
P.O. Box 10005
Incline Village, NV    89450
USA

Or call or FAX us at:
Phone: 702-832-4300
FAX: 702-832-4310



Order dialog box

Use this dialog box to fill out and print an order form for Digital Funhouse.

You can fill in the form and print out a completed order. Or, select the Clear    command and 
print a blank order form.

The Order menu fields are:

Ship To
Type in your complete mailing address and phone number.
Method of Payment
Select the method of payment from the list, check or credit card.
If paying by credit card, type in the credit card information.
Payment
Type in the number of copies of Digital Funhouse you want to order. Fill in the price fields 
based on the quantity being ordered. Nevada residents must add 7% sales tax. The shipping
cost is determined by the selected shipping option. The per item shipping cost is shown in 
the Shipping and Handling list.
Shipping and Handling 
Select the desired shipping option from the list.
Print Order 
Print the order form on the selected printer.    Choose the Setup option to change the printer 
and printer connection.
Setup
Displays a Print Setup dialog box, so    you can select a printer or fax and printer connection.
Clear
Clear all of the fields on the Order menu. This allows you to print a blank order form, or re-
enter the order information.
DF Info
Displays information about the full version of Digital Funhouse.



Legal Restrictions
COPYRIGHT AND WARRANTY DISCLAIMER
SYMSOFT CORP makes NO WARRANTY or representation, either express or implied, with 
respect to this software, its quality, accuracy, merchantability, or fitness for a particular 
purpose.    This software is provided "AS IS", and you, its user, assume the entire risk as to its
quality and accuracy.

Symsoft Digital Funhouse (TM) Demo copyright (C) 1994, Symsoft Corp
Symsoft Digital Funhouse Demo is solely owned by Symsoft Corp
All Rights Reserved Internationally

Symsoft Digital Funhouse Demo and associated files are contained in the self-extracting 
executable DIGFUN.EXE. This file may be freely distributed (subject to the restrictions below)
in its entirety but may not be altered in any fashion including deletion or addition of files, 
reverse engineering, decompiling or disassembling of code. 
RESTRICTIONS
Symsoft Digital Funhouse Demo (DIGFUN.EXE) is solely intended by Symsoft Corp as an end-
user demo program for the specific intent of allowing potential purchasers to "test-drive" the
software prior to purchasing the full version. No commercial purpose whatsoever is allowed 
for Symsoft Digital Funhouse Demo by any party but Symsoft Corp without prior written 
consent from Symsoft Corp and the payment of appropriate license fees.

Symsoft Corp/ POB 10005/ Incline Village NV 89450
702-832-4310/ FAX: 702-832-4310



File menu commands

The File menu offers the following commands:

Open Opens an existing image.
Save Saves an opened image using the same file name.
Save As Saves an opened image to a specified file name.
Export Exports a file for printing or faxing using another application
Acquire Acquires an image from a scanner
Select Source Selects the TWAIN scanning source
Print Prints an image.
Print Setup Selects a printer and printer connection.
Exit Exits Digital Funhouse.



Edit menu commands

The Edit menu offers the following commands:

Undo Reverse previous editing operation.
Copy Copies the image to the clipboard.
Paste Pastes an image the clipboard.
Convert to Gray Convert color image to gray
Image 
Enhancement

Choose an image enhancement tool

Select Effect Choose an effect



View menu commands

The View menu offers the following commands:

Entire 
Image

Display the entire image (shrink it if necessary)

Normal Display at the normal resolutino (100%)
200% Display image at 200%
400% Display image at 400%
800% Display image at 800%
Toolbar Shows or hides the toolbar.
Status Bar Shows or hides the status bar.

Help menu commands

The Help menu offers the following commands, which provide you assistance with this 
application: 

Index Offers you an index to topics on which you can get help.
Using 
Help

Provides general instructions on using help.

About Displays the version number of this application.



Image Enhancement menu commands

The Image Enhancement menu offers the following tools, which can be used enhance your 
image: 

Tone Adjustment Adjust the contrast, brightness and gamma in the image.
Color Correction Adjust the Red, Green and Blue levels in the image.
Sharpen Sharpen the image.
Remove Spots Remove spots from the image.



Open command (File menu)

Use this command to open an image. This command presents a File open dialog box, where 
you select the file to open.

Shortcuts

Toolbar:
Keys: CTRL+O



File Open dialog box

The following options allow you to specify which file to open:
File Name
Type or select the filename you want to open.    This box lists files with the extension you 
select in the List Files of Type box. 
List Files of Type
Select the type of file you want to open:
Drives
Select the drive in which Digital Funhouse stores the file that you want to open. 
Directories
Select the directory in which Digital Funhouse stores the file that you want to open.
Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



Save command (File menu)

Use this command to save the image to its current name and directory.    When you save an 
image for the first time, Digital Funhouse displays the Save As dialog box so you can name 
your image.    If you want to change the name and directory of an existing image before you 
save it, choose the Save As command.

Shortcuts

Toolbar:
Keys: CTRL+S



Save As command (File menu)

Use this command to save and name the image.    Digital Funhouse displays the Save As 
dialog box so you can name your image.    

To save a image with its existing name and directory, use the Save command.



File Save As dialog box

The following options allow you to specify the name and location of the file you're about to 
save:
File Name
Type a new filename to save a image with a different name.    A filename can contain up to 
eight characters and an extension of up to three characters.    Digital Funhouse adds the 
extension you specify in the Save File As Type box.
Save File as Type
Select the type of file you want to save:
Drives
Select the drive in which you want to store the image.
Directories
Select the directory in which you want to store the image.
Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



Export command (File menu)

Use this command to Export a file for printing or faxing using another application.    Digital 
Funhouse displays the Export dialog box so you can name your image.

Digital Funhouse creates an image that is optimized to give the best output for the selected 
output device (printer or FAX). Exporting to the TIF format in Black and White gives the best 
results when working with other word-processing or desktop publishing applications such as 
Microsoft Word , Aldus Pagemaker.



Export dialog box

The following options allow you to specify options, and the name and location of the file 
you're about to export: This dialog box is divided into several sections. The top portion of the
dialog box is for specifying the name for the exported file. The size options specify how big 
the image should be. The format    and resolution options specify the format for the exported 
image.
File Options
File Name
Type a filename to save the image to.    A filename can contain up to eight characters and an
extension of up to three characters.    Digital Funhouse adds the extension you specify in the 
Save File As Type box.
Save File as Type
Select the type of file you want to save:
Drives
Select the drive in which you want to store the image.
Directories
Select the directory in which you want to store the image.
Size Options
Width
Type in the desired width in the specified units, or by modifying the scale factor..
Height
Type in the desired height in the specified units, or by modifying the scale factor.
Units
Select the units to use for the image sizing and position fields.
Allow image distortion
Select this option to allow image to be distorted. When not selected, the width and height 
scale factors will alway be the same.
Format and Resolution Options
Black and White
A black and white (2-color) image is created.
Gray-scale
A 256 gray-level image is created.
Resolution
Select the resolution of your output device, printer or FAX.



Acquire command (File menu)

Use this command to acquire an image from a scanner. The Select Source command to 
select the TWAIN scanner device to use.

See Also
Scanning an Image



Select Source command (File menu)

Select the TWAIN scanning source



1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last four 
images you closed.    Choose the number that corresponds with the image you want to open.



Exit command (File menu)

Use this command to end your Digital Funhouse session.    You can also use the Close 
command on the application Control menu.    Digital Funhouse prompts you to save images 
with unsaved changes.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Undo/Can't Undo command (Edit menu)

Use this command to reverse the last editing action, if possible.      The name of the 
command changes, depending on what the last action was.    The Undo command changes to
Can't Undo on the menu if you cannot reverse your last action.

Shortcuts

Toolbar:
Keys: CTRL+Z or

ALT-BACKSPACE



Copy command (Edit menu)

Use this command to copy selected data onto the clipboard.    This command is unavailable if
there is no data currently selected.

Copying data to the clipboard replaces the contents previously stored there.

Shortcuts
Keys: CTRL+C



Paste command (Edit menu)

Use this command to insert a copy of the clipboard contents at the insertion point.    This 
command is unavailable if the clipboard is empty.

Shortcuts
Keys: CTRL+V



Convert to Gray command (Edit menu)

Use this command to convert a color image to 256 levels of gray.



Select Effect command (Edit menu)

Use this command to select a new effect to apply to your image. This command presents a 
Select Effect dialog box, where you select the file to open.

Shortcuts

Toolbar:



Select Effect dialog box

The following options allow you to select a new effect:
Effect Group
Choose the desired option group. When an option group is selected, the list of availabe 
effects In that group is displayed.
Effect
Choose the desired effect from the list of effects. As you highlight each effect name, a 
sample image is displayed to the left showing the results of this effect.



Tone Adjustment command (Edit menu)

This command selects the Tone Adjustment tool. Use this command to adjust the contrast, 
brightness and gamma correction for the image. The Tone Adjustment parameters are 
displayed in a tool bar at the top of the application window. 



Color Correction command (Edit menu)

This command selects the Color Correction tool. Use this command to adjust the red, green 
and blue levels for a color image. The Color Correction parameters are displayed in a tool 
bar at the top of the application window. 



Sharpen command (Edit menu)

This command selects the Sharpen tool. Use this command to sharpen (remove bluriness) 
the image. The Sharpen parameters are displayed in a tool bar at the top of the application 
window. 



Remove Spots command (Edit menu)

This command selects the Remove Spots tool. Use this command to Remove Spots from the 
image. The Remove Spots parameters are displayed in a tool bar at the top of the 
application window. 



Entire Image command (View menu)

Select this command to switch to the Entire image view. If the image is too large to display 
in the window, it will be shrunk so that you can view the entire image.



Normal command (View menu)

Select this command to switch to the view.The image is displayed at 100% (no zoom).



200% command (View menu)

Select this command to switch to the 200% view. The image is displayed at twice its normal 
size.



400% command (View menu)

Select this command to switch to the 400% view. The image is displayed at four times its 
normal size.



800% command (View menu)

Select this command to switch to the 800% view. The image is displayed at eight times its 
normal size.



Zoom tool

The zoom tool is used to zoom in on an area of the image.    You can use it to mark an area to
zoom in on, or to increase the zoom level at a specific point in the image.
To mark an area to zoom in on:
1.    Click on the zoom tool in the tool bar. When you move the mouse over the image, the 

cursor will be a magnifying glass.
2.    Move the mouse to one corner of the area you want to zoom in on.
3.    Click the left mouse button and drag the mouse to the opposite corner of the area.
4.    Release the left mouse button. Digital Funhouse will zoom in on the selected portion of 

the image.
To increase the zoom level at a specific point:
1.    Click on the zoom tool in the tool bar. When you move the mouse over the image, the 

cursor will be a magnifying glass.
2.    Move the mouse to the point you want to zoom in on.
3.    Click and release the left mouse button.Digital Funhouse will increase the zoom level at 

the specified location.



Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the 
most common commands in Digital Funhouse, such as File Open.    A check mark appears 
next to the menu item when the Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed on the left side of the application window.    The toolbar provides 
quick mouse access to many tools used in Digital Funhouse,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click To

Open an existing image.    Digital Funhouse displays the Open dialog box, in which 
you can locate and open the desired file.

Save the active image or template with its current name.    If you have not named the
image, Digital Funhouse displays the Save As dialog box.

Reverse the last editing.    Note:    You cannot undo some actions.

Print the image.

Turn on the zoom tool.

Select a new effect. The Select Effect dialog box  is displayed.



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be 
executed by the selected menu item or depressed toolbar button. A check mark appears 
next to the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the Digital Funhouse window.    To display or hide
the status bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to 
navigate through menus.    



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can
jump to step-by-step instructions for using Digital Funhouse and various types of reference 
information.    

Once you open Help, you can click the Contents button whenever you want to return to the 
opening screen.



Using Help command (Help menu)

Use this command for instructions about using Help.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of Digital
Funhouse.



Context Help command 

Use the Context Help command to obtain help on some portion of Digital Funhouse.    When 
you choose the Toolbar's Context Help button, the mouse pointer will change to an arrow 
and question mark.    Then click somewhere in the Digital Funhouse window, such as another
Toolbar button.    The Help topic will be shown for the item you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar

The title bar is located along the top of a window.    It contains the name of the application 
and image.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging 
their title bars.

A title bar may contain the following elements:
Application Control-menu button
Image Control-menu button
Maximize button
Minimize button
Name of the application
Name of the image
Restore button



Scroll bars

Displayed at the right and bottom edges of the image window.    The scroll boxes inside the 
scroll bars indicate your vertical and horizontal location in the image.    You can use the 
mouse to scroll to other parts of the image.

<< Describe the actions of the various parts of the scrollbar, according to how they behave 
in your application. >>



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the
arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer 

to the border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or 
dialog box with the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the Digital Funhouse window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a image window.



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single image, the Close command on the 
image Control menu closes only one window at a time.    You can close all windows at once 
with the Close command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a image window

ALT+F4 closes the <<YourType>> window or dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the 
Maximize or Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to 
or close an application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the 
following options:
Task List
Select the application you want to switch to or close.
Switch To
Makes the selected application active.
End Task
Closes the selected application.
Cancel
Closes the Task List box.
Cascade
Arranges open applications so they overlap and you can see each title bar.    This option does
not affect applications reduced to icons.
Tile
Arranges open applications into windows that do not overlap.    This option does not affect 
applications reduced to icons.
Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



Modifying the Image

<< Write application-specific help here that provides an overview of how the user should 
modify a image using your application.    

If your application supports multiple image types and you want to have a distinct help topic 
for each, then use the help context i.d. generated by running the MAKEHELP.BAT file 
produced by AppWizard.    Alternatively, run MAKEHM as follows:

makehm IDR_HIDR_,0x2000 resource.h

If the IDR_ symbol for one of your image types is, for example, IDR_CHARTTYPE, then the 
help context i.d. generated by MAKEHM will be HIDR_CHARTTYPE.

Note, AppWizard defines the HIDR_DOC1TYPE help context i.d. used by this help topic for the
first image type supported by your application.    AppWizard produces an alias in the .HPJ file 
for your application, mapping HIDR_DOC1TYPE to the HIDR_ produced by MAKEHM for that 
image type. >>



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.



Applying Effects
To apply an effect:
1.    Use the Select Effect command to select the desired effect.
2.    Select a region of the image to apply the effect to. If no region is selected, the effect is 

applied to the entire image.
3.    Set any effect parameters in the effect tool bar at the top of the screen. These 

parameters vary from one effect to another.
4.    Select the effect button in the effect tool bar at the top of the screen. A dialog box is 

displayed showing the progress of the effect processing. Select Cancel in this dialog box to
cancel the effect.



Selecting a Region

From the selector list box in the effect tool bar, choose the selector type, Rectange, Ellipse or
Circle.
To select a rectangular region:
1.    Move the mouse to one corner of the region to select.
2.    Click the left mouse button and drag the mouse to the opposite corner of the rectangle 

to select.
3.    Release the left mouse button. A rectangle on the image shows the selected region.
To select a elliptical or circular region:
1.    Move the mouse to center of the ellipse or circle to select.
2.    Click the left mouse button and drag the mouse out from the center point. The ellipse or 

circle is drawn as the mouse moves.
3.    Release the mouse button. An ellipse or circle on the image shows the selected region.
To de-select a region:
1.    Move the mouse over the image and click the right mouse button. The region is no 

longer selected.



Scanning an Image

Digital Funhouse supports the TWAIN interface for scanners and video input devices. You 
must have TWAIN support for you scanner installed to be able to scan images with Digital 
Funhouse.

There are two commands on the File menu that are used for scanning. The Select Source 
command is used to select the TWAIN device to scan from. If you only have one TWAIN 
device, you will not normally need to use this command.

The Acquire command is used to get an image from a TWAIN scanner.





Print command (File menu)

Use this command to print an image. This command presents a Print dialog box, where you 
may specify the size and placement of the image on the page, the destination printer, and 
other printer setup options.

Shortcuts

Toolbar:
Keys: CTRL+P



Print dialog box

The following options allow you to specify how the image should be printed:
Printer
This is the active printer and printer connection.    Choose the Setup option to change the 
printer and printer connection.
Setup
Displays a Print Setup dialog box, so    you can select a printer and printer connection.
Page Setup
Select the page setup method, numeric, input numbers for size and position of image, or 
visual, click and drag a thumbnail image to the desired size and postion on the page..
Allow image distortion
Select this option to allow image to be distorted. When not selected, the width and height 
scale factors will alway be the same.
Width
Type in the desired width in the specified units, or by modifying the scale factor..
Height
Type in the desired height in the specified units, or by modifying the scale factor.
Top
Type in the desired postion in the specified units for the top of the image on the page. This 
option is not active if Centered on Page is selected.
Left
Type in the desired postion in the specified units for the left side of the image on the page. 
This option is not active if Centered on Page is selected.
Centered on Page
Select this option to automatically center the image on the page.
Units
Select the units to use for the image sizing and position fields.



Print Progress Dialog

The Printing dialog box is shown during the time that Digital Funhouse is sending output to 
the printer.    The percentage indicator shows the progress of the printing.

To abort printing, choose Cancel.



Print Setup command (File menu)

Use this command to select a printer and a printer connection.    This command presents a 
Print Setup dialog box, where you specify the printer and its connection.



Print Setup dialog box

The following options allow you to select the destination printer and its connection.
Printer
Select the printer you want to use.    Choose the Default Printer; or choose the Specific 
Printer option and select one of the current installed printers shown in the box.    You install 
printers and configure ports using the Windows Control Panel. 
Orientation
Choose Portrait or Landscape.
Paper Size
Select the size of paper that the document is to be printed on.
Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.
Options
Displays a dialog box where you can make additional choices about printing, specific to the 
type of printer you have selected.
Network...
Choose this button to connect to a network location, assigning it a new drive letter.






